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(cn)Chapter 2

(ct)Build A Simple, Static LiveMotion Web Page 

 (2)In this chapter, you'll learn how to:

· Use an all-vector workflow to create fast-downloading Flash movie files

· Learn about the tools available in the LiveMotion toolbox

· Create, select, and edit geometric objects

· Arrange objects by grouping them, changing their stacking order, or combining them

· Apply colors to objects

· Create and use text

· Create outlined objects

· Duplicate objects and create aliases

· Export a Flash movie with working links

LiveMotion can be used to produce many types of Web pages and Web elements. One of the realities of Web design is that "smaller is better"—always, in today's Web environment. The page that downloads fastest is usually best. If you're creating a page with a number of graphics on it, download speed can slow to a crawl unless you design the page very carefully. Of all of the Web graphics formats available today, the Flash format (.swf) has the advantage of swift download if you take care to create objects that export as vectors. In this chapter, you'll learn to use the basic creation tools in LiveMotion at the same time as you create a Web page that uses only vector elements. 

Figure 2-1 shows the page that you'll create. As you work toward that goal, you'll learn how to create vector shapes in LiveMotion, and learn the basic of working with LiveMotion. The page you’ll create is not animated; it doesn't sing or dance, but it contains all of the basic elements that are needed on a Web page: images, text, and links. You'll begin to learn how to move objects and animate them in Part II, but you need to learn the fundamentals first before you can fly. 

Once you’ve learned the basics of creating vector shapes in this chapter, you can get all the details of creating LiveMotion animations in Chapters 5-8.

Figure 1: You'll learn how to create this Web page in the course of this chapter

(1)Use an All-vector Workflow

Are vector shapes always better? Of course not. However, vector images, because they are based on math constructs rather than on specific pixel coordinates, have the advantage of producing smaller graphics files and therefore tend to download much faster. You  can't specify whether objects will export as vector or raster graphics; LiveMotion decides that when you generate your output. Based on the type of object and its complexity, LiveMotion decides whether to export a raster object or a vector object. You'll learn in a minute what the criteria are for each object export type.

(2)Recognize the Various Types of LiveMotion Objects

Everything that you create or place in LiveMotion is an object. An object is an individual entity that can be moved, changed, transformed, etc. by itself. LiveMotion recognizes four types of objects:

· Geometric objects are based on the geometric creation tools in LiveMotion (the Rectangle, Ellipse, Rounded Rectangle, and Polygon). This category also includes objects that you import from Adobe Illustrator or other vector drawing programs such as Corel DRAW or Macromedia Freehand. 

· Text objects are objects that you create using the Text tool in LiveMotion. The text remains editable while you are in LiveMotion. When you export the text, it's converted to a either a GIF, JPG, or PNG file or included in a Flash movie. In either case, the site visitor doesn't need to have the fonts that you used installed on their machine.

· Image objects are the objects that you import from raster graphics programs such as Photoshop, Painter, Corel PhotoPaint, or PaintShop Pro. 

· Sound objects are imported sound files. You won't see them in the Composition window. Instead, these objects will show up in the Timeline.

The image object, of course, can only export as a raster file because it was a bitmapped or pixel-based file from the very start. Geometric and text objects can export as either type.

(2)Use Preview Export Compression to see what You’re Exporting

How can you tell in advance if you are creating a raster or vector export object? You can't tell by the export options—because LiveMotion itself decides whether to export the object as raster or vector. You can't tell by the file extension—there is no difference.

 You can tell either because you know the rules (you'll learn them in a moment) or because you've looked at the icons for each object while using the Preview Export Compression feature. 

Objects export as vector if they contain only one layer and have no effects applied to them. If an object shows up in the Properties palette as filled , it can contain either a gradient, an opacity change, or an opacity gradient—but only one of these. If it has multiple changes, then it exports as a raster object. If the object shows up in the Properties palette as  stroke, you can add changes in opacity, but as soon as you add either a gradient or an opacity gradient, the object becomes a raster export. Text that contains a gradient  or uses a gradient opacity will export as a raster object. The Double Burst Opacity gradient always exports as a raster object. Any geometric or text object that doesn't meet the requirements for vector export is exported as a raster object. An object that appears in the Properties palette as having an Alpha channel is really a raster object. But if it is a solid color, a single layer,  and contains no changes in opacity and no gradient, it can also export as a vector object.
In the first sentence of the paragraph above I don’t know what you mean by “If an object is a path…”? I thought an object would be on a path?  Or move along a path? Or maybe the object that you export contains a path? I guess the oMaybe it is just terminology that I’m not familiar with because I see that an object can also be a stroke further along.  I think I’m getting the idea. Jc Jody, I think this is more clear. SL
Because vector objects are faster to download when you export to a Flash movie, LiveMotion allows you to preview your objects so that you can interactively change them to optimize them for export. This feature is enabled in the View menu as shown here. 

Illustration 1
When the feature is enabled, you'll see a checkmark in front of it in the View menu. To turn off  Preview Export Compression, select the item again in the View menu. The checkmark will disappear. 

Caution: Only use Preview Export Compression when you want to check the status of your export. It dramatically slows down the application performance. Don't try to work with the feature turned on all of the time.

Figure 2-2 shows part of the Web page that you'll create as viewed in the Preview Export Compression window. The woman is selected (as indicated by the bounding box around her). If you could see this in color, the bounding box is red, which means that Preview Export Compression is on (when it's off, the bounding box is blue). The pen icon on the right at the bottom of the image shows that the selected object exports as a vector. 

Figure 2: Web page with Preview Export Compression turned on shows export statistics

Figure 2 callouts:

Total size of exported page

Size of selected object

Object Export type icon (shows vector export object)

(2)Vector Web Page Workflow Steps

Shown below are the workflow steps that you'll use in this chapter. You can follow this basic process even when you create more complex pages (although you won't always care if you export only vector objects, and in some cases, you might not want to export as a Flash movie). 

1. Design and build the page.

2. Check the Export Settings.

3. Check all of the objects in the Preview Export Compression window to make sure that they are vector.

4. Test the page in your browser.

5. Export the page as a Flash movie.

6. Test the exported file to make sure that it works.

(1)Learn The LiveMotion Interface 

I want to give you a brief introduction to the items that you'll use to build objects and web elements. Although I could go into depth about each menu item, palette, and toolbox item, instead I'll briefly identify the main "players" and then give you more in-depth information about each item when you actually use it for the first time. Otherwise, the volume of new information becomes overwhelming (and you won't remember it all anyway). Figure 2-3 shows the main elements of LiveMotion's interface.

Figure 3: LiveMotion offers a number of ways for you to control your compositions
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(2)The Menus

LiveMotion's main menu bar across the top of the application gives you access to the major program commands and features. 

Illustration 2
· The File menu allows you to open, create, and save files, place, replace, and import images, choose Export settings, export your files, preview, print, and exit LiveMotion. 

· The Edit menu allows you to undo one or multiple steps, cut, copy, paste, select, deselect, duplicate, create aliases or break them, and change Online settings, image preferences, and Composition settings.

· The Object menu stores the commands that you use for working with objects. It allows you to arrange, align, and distribute objects, group or ungroup and combine or uncombine them. You can also create a mask, break apart text, and apply filters and transformations. 

· The Layer menu allows you to add, delete, duplicate, and order layers and clear layer attributes.

· The Timeline menu controls your animations by allowing you to show or hide the Timeline window, navigate between keyframes, create looping or timeline independent movies, set ease on or ease out on   frames, and clear the animation.

· The View menu contains a variety of preview options, and allows you to specify grids, guides, rulers, and zoom levels. 

· The Window menu lets you show and hide the various palettes that come with LiveMotion. 

· The Scripts menu lets you edit and debug scripts written in the LiveMotion scripting language, which is a form of JavaScript. 

· The Automation menu lets you load Live Tabs extensions to LiveMotion and apply previously written scripts to LiveMotion objects. 

· The Help menu allows you to either connect to Adobe Online or to view the Help system for LiveMotion. LiveMotion help is browser-based and will open in your default browser window—even if you're not connected to the Internet at the time. You can use the help menu to quickly look up any command for which you need more information.

 (2)The Palettes

LiveMotion provides controls to alter your objects by giving you a variety of palettes. These palettes “live” in containers that are tabbed to save space. If you have used either Photoshop or Illustrator, you’ll see that using LiveMotion's palettes are similar. The Toolbox and the Timeline are not really palettes, but the other items shown on this abbreviated version of the Window menu  are palettes and are arranged  into their default container groupings. 

Illustration 3
If you have a small monitor, you'll probably prefer the additional screen real estate to a view of the entire palette subsystem. 

You can rearrange the palettes into different containers just by dragging and dropping them. A palette removed completely from a container grows its own. You can close palettes by clicking on their close button (upper-left corner on the Macintosh, upper-right corner X-box on Windows). Use the Window menu to show them again. 

Shortcut: You can hide all of the palettes and the toolbox by pressing the Tab key. Press the Tab key again to show them all again. Shift+Tab hides the palettes but not the toolbox.  
Note: You need to have a composition window open in order to get the shortcuts to work. 
I had to have a composition window on the screen for this to work.  You might put this tip after you discuss the composition window below?  jc
I'll talk about each palette in more depth when you use it for the first time. 

(2)Use The Composition Window to Create Pages

The Composition window is where you'll create your pages. You create a new Composition window every time you choose File | New. You can specify the size of your composition when you create it or you can alter the size later using the Edit | Composition Settings menu option.

Shortcut: You can use Command+N on the Macintosh or Ctrl+N on Windows to create a new composition, and you can edit the composition settings by choose Shift+Command+N on the Mac or Shift+Ctrl+N on Windows.

(2)The Timeline

The Timeline window enables you to create animations and add behaviors to control the animations. You used the timeline in the short animation in Chapter 1. You won't need add any key frames to it in this example. 

(1)Work with Geometric Objects

Now that you've met the menus, the palettes, and the tools, and you know about the desirability of creating vector objects for export,  you're finally ready to begin to create something. Let's see how you can create some simple objects and then add to their complexity.

 (2)Create Objects with LiveMotion's Geometric Tools

Before you actually start to build the Web page for this chapter, you’ll need to understand how to create objects using the LiveMotion toolbox. LiveMotion has four tools that create basic geometric shapes. They are the Rectangle tool (shortcut: m), Ellipse tool (shortcut: l), Polygon tool (shortcut: n), and Rounded Rectangle tool (shortcut: r). To use the shortcuts for the tools, just type the letter on your keyboard.

Let's play with these shapes before beginning the actual "work."

To create geometric objects, follow these steps:

1. Launch LiveMotion.

2. Choose Window | Reset to Defaults to set all of the positions and colors back to their original settings to ensure that we are all playing in the same ballpark.

3. Click on the green Color Scheme swatch (it's the top-left swatch in that section of the toolbox). Figure 2-4 shows the location of the Color Scheme Swatches. 

Figure 4: The geometric tools and the Color Scheme and Color Swatches

Figure 2-4 callouts:

Rectangle tool (m)

Ellipse tool (l)

Rounded Rectangle tool (r) (should be ( r )  jc
Polygon tool (n)

Current Fill color swatch

Background color swatch 

Color Scheme swatches
I did not see a the figure with callouts for Figure 2-4 among the zipped files?  Jc Mis-numbered as 5c.  SL
4. Choose File | New. In the Composition Setting dialog box, enter 796 pixels for the Width and 512 pixels for the height. (This size is approximately the size of the area left free in a browser window that fits on an 800 x 600 monitor screen.)

Illustration 4
Leave the Frame Rate at 12 frames per second (although this movie will have only one frame so it really doesn't much matter how the frame rate is set .). 

5. Select the Rectangle tool. Place your cursor anywhere in the Composition window and click and hold the mouse button. Drag the cursor (with the mouse still pressed) toward the right and down. Release the mouse button when your rectangle is the desired size. 

6. Create an ellipse, a rounded rectangle, and a polygon. 

7. You can easily change one shape into another shape. In the Properties palette, with the Selection tool as your active tool, choose the type of object that you want as shown in Figure 2.5. Change a rectangle into a rounded rectangle.

Figure 5: Select the desired shape from the drop-down menu

Tip: You can change the amount of curve on a rounded rectangle by dragging the Radius slider on the Properties palette to a different location. You can set the radius to anything between totally sharp edges to an ellipse.

Production: The following box is a How to box.

(6)Change the Number of Sides on a Polygon

To change the number of sides on a polygon you’re creating, first, make the Properties palette active by clicking on its tab. Make sure that you can see a bounding box around the polygon that you want to alter. If you can't, then use the Selection tool to select the object. Drag the Sides slider to your desired number of sides (from 3 to 10) and you’ll see the objects’ shape change on your screen. You can change the number of sides to a polygon any time you want.

End How-To Box

Production: The following box is a Did You Know? box.

(6)Did You Know?

After you create a shape, the shape tool that you used remains selected until you choose a different shape tool. If you decide that you dislike this behavior, you can change it. Select Edit | Preferences and checkmark the Auto-Revert to Arrow Tool checkbox. I would actually recommend that you do change the behavior because LiveMotion has an annoying knack of leaving tiny, empty objects all over your composition anytime you click if a tool other than the Arrow tool is active. 

End special formatting

Now that you've created a few objects, you need to know a bit more about how LiveMotion manages objects. Make the Object Layer palette active by clicking on its tab. 

Illustration 5
Select an object. Notice that you see one layer. When you create a new geometric object using one of the geometric tools, the object consists of only one layer to start.
Again you have to have an object selected for this to work.  Jc OK. SL
LiveMotion uses a dramatically different layer paradigm than either Photoshop or Illustrator. In both Photoshop and Illustrator, you can have multiple objects or image on a layer, and the layers organize the various sections of a document. In LiveMotion, all objects on are on the same plane in the Composition window. However, within each object, you can have multiple layers. 

You'll learn more about object layers in Chapter 3. Here's a rule for you to memorize, however: if you want to export an object to a Flash movie as a vector, it can only have one layer. All of the objects that you'll create in this chapter, therefore, will only have one layer.

 (2)Select Objects So You Can Manipulate Them

Once you've created some objects, you'll need to select them again in order to be able to work with them. You can only move, resize, transform, or otherwise mangle an object that is selected. A selected object is surrounded by a bounding box marquee. 

LiveMotion has several ways to select objects. Here are the most common:

· Choose the Selection tool (shortcut: v). Click on the object that you want to select. It will gain a bounding box to show that it's selected.

· Choose the Drag Selection tool (shortcut: u). This tool is most useful for selecting multiple objects. Drag the tool around more than one object to select all of the objects that you have surrounded.

The Drag Selection tool only selects objects that it completely surrounds. If you only drag over a small portion of an object, you won't select it. You can actually see the bounding boxes appear as each object is selected. 

Tip: You can drag select with the selection tool as well, but it's too easy to accidentally move something when you use the Selection tool. If you use the Drag Selection tool, you won't move anything. 

Start Did You Know box

(6)Did You Know?

You can temporarily select any tool that you want by holding down its shortcut key. You can draw a rectangle while you have the Selection tool active by pressing the M key. You can use the Selection tool while the Rectangle tool is active by holding the V key. Although this behavior is unique to LiveMotion, you might well see the same ability in other Adobe products in the future.

End special format

(2)Specify the Size of Your Objects

LiveMotion gives you several ways in which to specify the size of an object. You can use the grid or the rulers to help you set the set of the object as you create it. You can use the Transform palette to specify an exact size. You can interactively change the size of an object.

(3)Use the Grid or the Rulers to Resize an Object

To turn on the ruler, choose Show Rulers from the View menu (shortcut = Command+R on the Mac or Ctrl+R on Windows). You also turn on the grid from the View menu (View | Show Grid). You can set the size of the grid in the Edit | Preferences dialog box shown in Figure 2.6.

Figure 6: The Preferences dialog box for LiveMotion

If you use the grid, you can also choose to have objects snap to it if you want. Simply select View | Snap to Grid.

(3)Use the Transform Palette To Resize an Object

You can specify an exact size for an object by changing the Width or Height box in the Transform palette as shown in Figure 2-7. All of the units are in pixels, so entering 200 in the Height field sets the object height to 200 pixels. You need to press the Enter or Return key or tab to a new field before you see the result of your changes on the screen.

Figure 7: Using the Transform palette

Figure 2-7 callouts

Move left to right

Move up or down
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Set Width

Set Height
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Vertical Skew
I didn’t see the callouts for 2-7 in the zipped files. Jc Forgot it. I will resend. SL
(3)Resize Objects Using the Bounding Box

LiveMotion's bounding box resizing is quite similar to Illustrator's or to the Free Transform command in Photoshop. The bounding box of an object has eight control handles (four corner handles and four mid-point handles). Figure 2-8 shows the bounding box of an object. 

Figure 8: The bounding box

Figure 2-8 callouts

Place cursor here to rotate

Drag to make taller or shorter

Drag to make narrower or wider

Drag from solid corner to resize width and height at one time

Seven of  the control handles are solid. The hollow control handle is a "special case." Placing your cursor over that handle allows you to rotate the bounding box of the object. You can drag on the top or bottom control handle to make the object taller or shorter. The side handles allow you to widen or narrow the width of the object. The side handles allow you to change height and width at one time.

The behavior of the bounding box is unique among Adobe applications. When you drag a control handle on a bounding box, you resize from the center of the object. When you press the Shift key as you resize, you constrain the object to a circle or square (or an object with equal sides) but only if you drag a corner handle. If you're familiar with other Adobe applications, this is a major change in behavior (usually, you need to hold the Option/Alt key to resize from the center and the Shift key keeps the original object aspect ratio). In LiveMotion, you need to hold the Option or Alt key if you want to resize or rotate from a point on the bounding box.
I didn’t notice any difference in behavior if I was holding the shift key down.  I did notice the alt key change. Jc You need to drag a corner handle. SL
 (2)Create a Navigation Bar Base for a Web Page

Now that you've seen how to create the basic objects, you can begin to create the Web page shown at the start of this chapter. The first thing you place is the side navigation bar background, and then you will lock it.  

To begin, you'll create your basic page size, and then you'll create a box that will act as the base of the navigation bar at the side of the page shown in Figure 2-1.

1. Open a new Composition window (File | New). In the Composition Setting dialog box, enter 796 pixels for the Width and 512 pixels for the height. 

2. Create a new rectangle somewhere in the Composition window. 

3. Move the rectangle (using either the Selection tool or the v key) to the left side of the window. Try to center it so that there is equal space to the above and below it.

4. Place your cursor on the center-top control handle of the bounding box and drag the handle toward the top until the top of the object is even with the top of the Composition window. Notice that the bottom also moved the same amount. Is the rectangle also even with the bottom of the image? If not, use the Transform palette to set the height 512 and the width to 109 pixels. The X: and Y: positions should be 0. (You could also position the bar at the top of the screen and press the Option or Alt key as you drag the center-bottom point to the bottom of the screen.)

Tip: If you want to size the navigation bar "by eye," then create the rectangle by drawing it from the upper-left corner of the Composition window to start. You can draw an object from its upper-left corner, but you can only resize an object from its center.

5. With the rectangle bar still selected, set the Color palette to RGB: 201, 185, 139 to make the bar a light tan. 

6. Press Cmd+T on the Mac or Ctrl+T on Windows to show the Timeline. Click on the Lock column to the right of the entry for the rectangle. This prevents you from accidentally moving the navigation bar.

Illustration 6
7. Finally, set the color for the background of the Web page to RGB: 255, 242, 223 by making the Background color patch active in the Toolbox and then dragging the RGB sliders in the Color palette or just entering the numbers in the appropriate boxes. 
 (or just entering the numbers in the appropriate boxes) jc OK
 (2) Create Shaped Objects

Now that you have the navigation bar in place, you're ready to create some additional objects. You will place a man, woman, and apple into your image by dragging them from LiveMotion’s Library palette. 

Here's how:

1. In the Library palette, scroll down until you see the small man. (The name of the shape is Man if you look at the Library via the Name or Preview view.)

Illustration 7
2. Click on the man icon and then click on the Place icon at the bottom of the Library palette as shown in Figure 2-9. 

My “place object icon” was not working (when I clicked it nothing happened) but I could drag and drop the man onto the page.  Jc Jody, I assume it will work in the release version <grin>
Figure 9: The Library palette icons

Figure 2-9 callouts

Show LiveMotion objects
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Make Mask

Place Object
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Delete Entry

Start Did You Know box

(6)Did You Know?

The Library palette stores objects that you can use in any project. You can even add your own objects to this palette so that you can quickly reuse them.

End special format

3. In the Transform palette, change the object width to 131 and the object height to 339. Set the X: position to 182 and the Y: position to 104. Press the Enter or Return key to make the Y: field register. Because I pre-designed this page for you, I get to choose the locations where I think things look best. There's no magic to the numbers that I  use. If you prefer a different arrangement, go for it. The location and size of the objects are not important to the technique of creating the page.

4. Change the color of the man to RGB: 165, 255 88.

Now you want to make sure that the object will export as a vector shape so you’ll need to select the man, and choose View | Preview Export Compression. As you can see, 

Illustration 8
the Pen icon indicates that you've created an all-vector shape. Turn off the Preview Export Compression by selecting it again in the View menu.  Lock the man. 
Next, let's create a woman as a companion for the man. Here's how:

5. In the Library palette, locate the Woman symbol. Click on the Place Object icon to add the woman to the Composition window. 

6. In the Transform palette, change the width to 161 and the height to 303. Move the object (via the Transform palette) to X: 262 and Y: 137. 

7. Change the color of the woman to RGB: 204, 186, 0. Lock the woman.
8. Add the Apple symbol the same way that you added the man and the woman. Change the apple's color to RGB: 255, 0, 0. Use the Transform palette to change the apple to 207 pixels wide by 327 pixel high. Then move the apple to X: 341 and Y: 167. 

9. The apple is now in front of the figures, however, and it needs to go behind them. Choose Object>Arrange>Send to Back. Lock the apple.
Save your work (File | Save). You can name the file LIFESTYLE.LIV

 (1)Create Text in LiveMotion

The Type tool in LiveMotion enables you to create text that will export as a graphic in your final page. You can create text as a single word or phrase (point text) or set text as an entire section (paragraph text). You can specify the font and font size, the leading, alignment, and tracking. You can create either filled type or stroked (outlined) type but not both on the same object.

One of the problems with using fancy fonts on the Web is that if you use a font in a browser page, your site visitor needs to have that font installed in order to be able to see it in the page. Most designers find this both frustrating and limiting because they have no idea what fonts are installed on a site visitor's computer. When you use the Type tool, however, you create text that will display in any browser because it's no longer text at all—it's a graphic.

Begin Did You Know…?

(6)Did You Know…?

Typography as a major study area is outside of the scope of this book. However, you should know some of the very basic typographic concepts:

1. A font is a set of letterforms that have been designed to be used together. In "computer" terms, a font is the file that you purchase that contains the letterforms. Traditionally, a font was a set of letterforms at one specific size and weight. 

1. Fonts have different styles. The most common styles are plain, italic, and bold. Don't underline a font unless you want to make a text-based hyperlink on a Web site. 

2. Fonts also have different weights. The typical text weight for a font is book or roman. Bold, black, and light are other weights. LiveMotion can't create weights or styles for fonts. It can only use the fonts that are part of the font family that you've purchased. If you have a Helvetica Condensed font, you can select it; LiveMotion can't build it for you if you don't have that weight. 

3. Font Sizes are specified in terms of points. 10 or 12 point type is typical "typewriter" size of book size. There are 72 points to an inch. 

4. Alignment can be left-justified, centered, or right-justified and can read left-to right or vertically. The alignment sets the point from which the type originates. Center alignment creates an even amount of type on either side of the center point.

5. Leading is the space between the lines of type. Actually, leading refers to the space between the baselines of rows of type. The baseline is the imaginary line on which the type rests (without the descender letters such as j, q, g, p, y, or f). "Automatic" leading leaves approximately 120 percent of the font size between lines. Twelve point leading with ten point type is standard leading. 

6. Tracking is the space between letters. A positive number makes the word take up more room on the screen, while a negative number brings the letters closed together. The size of the actual letters doesn't change at all. 

7. Kerning is setting the tracking for a single pair of letters without changing the spaces between all of the letters in the text box. LiveMotion cannot do any form of kerning in this release. If you need to kern your letters, do it in Illustrator. 

End Did You Know

In the Web page that you're creating for this chapter, you'll need to create text for the name of the Web site and for the buttons that are used to link the main page to the other pages in the site. Here's how to create the Web site logotype. 

1. Select the Type tool and click in the image. You can begin typing wherever you click. Just as in Photoshop and Illustrator, you type directly on the image. The Properties palette changes to show you the font and formatting options.

2. Type the words " A Healthy Lifestyle". As you can see in Figure 2-10, I used 62 point type with a tracking value of -10. The font that I used was Fajita ICGMild by ICG. You can use any decorative font that you have on your system (or a solid-looking plain font if you have nothing decorative). You will see the all of the type options in the Properties palette when you choose the Type tool.

Figure 10: The Type Tool Properties palette

Figure 2-10 callouts
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3. Change the color of the font to RGB: 49, 150, 0 in the Color palette. 

4. In the Transform palette, change the X: position of the text to 205 and the Y: position of the text to 410.

5. Save your work. It should look like Figure 2-11

Figure 11: Web page after adding logotype

(1) Create Outline Objects

Any geometric object can be displayed as either a filled object or a stroked object (outlined) object. However, an outlined object will only export as a vector shape if it a solid color. You are going to create an outlined object to act as a door. Its base will be a solid rectangle.

Here's how to create the doorway.

1. Select the Rectangle tool and draw a rectangle in an empty spot in the Composition window.

2. Use the Transform palette to change the size of the rectangle to 150 pixels wide by 396 pixels high. Set the X: position to 145 and the Y: position to 58. 

3. Hmmmm…The rectangle is now in front of the people. You need to place the rectangle behind the people. Choose Object | Arrange | Send To Back. 

4. Set the Color palette to RGB: 47, 66, 48. 

This looks dark green on my laptop.  Jc ??? SL
5. In the Properties palette, change the radio button to Outline and enter an outline width of 56 (1/4) pixels. If you've used a vector drawing program, this is the equivalent of setting the object to a Fill of none and a stroke of 14 pixels. 

The right side of the outline is a bit strong for the image, so in the next section, you'll learn how to duplicate the object, change its color and add an opacity gradient that will soften the right edge of the door outline.

(1) Duplicate an Object and Add an Opacity Gradient

LiveMotion allows you to create duplicate objects. You can duplicate objects in several ways. You can copy and paste or you can use the Duplicate command. You can also make a copy interactively by dragging an object, as you can in other Adobe applications, with the Option or Alt key pressed. In addition to these methods, you can create aliases of an object. You'll learn more about aliases later in this chapter. 

In this next series of steps, you'll duplicate the door that you've just created and then add an opacity gradient (an opacity gradient  changes the opacity of the object from one portion of the object to another) to soften it. Here's how:

1. Choose Edit | Duplicate. This makes a second copy directly in front of the first one. (But the copy is in front of all of the other objects.)

2. Using the Selection tool, move the  duplicate object until its upper-left corner just touches the inside top-left corner of the door frame outline.

Ooops I accidentally moved the man.  Maybe we should have locked him first. I went back and added it. SL
3. Press the Option (Mac) or Alt (Windows) key and drag the center-bottom point of the  object until it reaches the bottom of the crossbar in the "A" of the logotype. 

4. Change the color in the Color palette to RGB: 201, 185, 139.

5. To make the object appear in the correct stacking order, choose Object | Arrange | Send To Back and then Object | Arrange | Bring Forward. That places the duplicate in front of the original door. 

6. Change the object to Fill in the Properties palette by clicking on the Fill option button.

7. To add an opacity gradient, make the Opacity palette active. Don't change the Object or Object Layer opacity. They should remain at 100 percent, as you can see in Figure 2-12. Instead, click on the double-arrow to the right of the "No Gradient" text, and select "Linear" from the drop-down list. Drag the Angle control so that it points to the left and the numeric entry field reads -180 degrees. The bottom bar controls the overall settings of the opacity gradient and sets the points at which the object begins to fade. Drag the black slider on the left until it is directly below the last "e" in "Relative." This makes the gradient take longer before it begins to fade. (Black in the slider is opaque and White is transparent.)

Figure 12: The Opacity Palette

Figure 2-12 callouts

Gradient Type
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White (Transparent) point

Gradient Angle Control

Gradient Angle Numeric Entry Field 

8. Check that you still have a vector object by pressing Command+9 (Mac) or Ctrl+9 (Windows) to select the Preview Export Compression. You should see the Pen icon. Remember to turn the control back off. 

I did something wrong since I ended up with a dark frame and then instead of a solid fading door it is a second fading frame.  Did I miss the step that changes the door to “fill” instead of “outline” for the frame?  I looked back and can’t see it?  Jc I added the step. Great catch! SL
9. Save your work.

(1)Arrange Objects to Create a Navigation Bar for your Web page

A navigation bar in a Web page allows you to see a list of choices for locations that you can visit directly form the Web page. One of the key elements in creating a usable Web site is to make it as easy as possible for the Web site visitor to locate the information that they came to your site to find. By creating a navigation bar that shows all of the major locations, the site visitor can easily move from area to area in your site. 

In order to create the navigation bar, you'll need to learn a few additional skills. Yes, I know that this chapter is long and might contain many new concepts for you, but the advantage is that once you've successfully mastered this chapter, much of the rest of this book will be easy. You'll have already met, in their simplest form, almost all of the main skills needed except for scripting and creating animations. To create the navigation bar, you'll need to learn more about arranging objects.

You can arrange objects in your Composition window in many different ways and by using a number of commands. You can alter the shapes themselves by combining them or using the Pathfinder commands on them. You can group objects so that they move together as one. You can stack objects that they fall behind or in front of one another. You can also align objects so that they are horizontally or vertically in straight lines or distribute then so that the space between them is even.

 (2)Create Aliases

On a Web page or Web site, you sometimes need to create multiple copies of the same image element. An example would be the need to create a number of identical buttons that differ only in the text that they contain. To create such buttons, you could make the button base and duplicate it many times and then add a text object on top of each button. That's fine—until you decide that you really want the buttons to be orange and not yellow or you want each button to have rounded corners rather than to be square. 

LiveMotion allows you to create aliases of an object. An alias is not only an exact copy, it's a linked copy. If you make any change to any of the aliased objects, they all acquire the same change. After you create the basic navigation rectangle in the next set of instructions, you'll create aliased objects that will become your button shapes. 

1. Deselect all objects in your composition by clicking off of them.

2. With nothing selected, change your current Object color to RGB: 255, 0, 0​—the same color red as your apple. 

3. Place your cursor somewhere on an empty spot in the navigation bar base on the left of the Composition window. Choose the Rounded Rectangle tool (r). Drag to create a small rounded rectangle object. 

4. Choose Edit | Make Alias (shortcut: Mac: Command+M, Windows: Ctrl+M). Repeat this command three more times. You'll have five of these rectangles. All five shapes are directly on top of one another (so it still looks as if you only have one object).

5. Use the Drag Selection tool to select all five buttons and move them as a group on the navigation bar so that the top of the buttons are aligned with the top of the door frame (but still on the navigation bar).

6. Use the Selection tool to select the top rounded rectangle and move it down on the navigation bar so that it is approximately the same distance from the bottom as the other buttons are from the top. 

I used the “show grid” and “snap to grid” to help get these equally spaced.  Never mind – I see later we are going to distribute these objects.   jc

7. Select the top button object. Change the Properties palette from Fill to Outline, and select 8 as the outline width. Notice that when you change one instance of an alias, they all change. 

8. Change the size of the selected rectangle in the Transform palette to 101 pixels high by 26 pixels wide. Again, all of the linked rectangles change size.

Note: If you decide that you need to change some but not all of the objects that are linked as aliases, you can chose Edit | Break Alias. 

(2)Distribute Objects

After you have created the five linked buttons and dragged them onto the navigation bar, you need to place then so that they are evenly spaced on the navigation bar. To space objects even in LiveMotion, you use the Distribute command. It allows you to leave either horizontal or vertical space between objects. Here's how to distribute the button aliases evenly between the ones on the top of the navigation bar and the one alias that you dragged 3/4 of the bar toward the right:

1. Drag select all of the rounded rectangles.

Tip: Because you need to drag across an entire object in order to select it, dragging from bottom-right to top-left across the objects will be the easiest way to select them all.

2.  Choose Object | Distribute | Vertical. Don't worry if the rounded rectangles aren't perfectly even. You aren't finished with them yet.

3. Press the v key as you click away from any object to deselect everything.

4. Save your work.

(2) Group and Align Objects

LiveMotion won't allow you to create a single object that consists of both text and a geometric shape. The only way to place text onto a button is to create a separate text object that is on top of the button. You then need to align the center of the button with the center of the text. Then you need to group the text and underlying button to keep them together. Finally, you need to align all of the buttons so that they are straight. Here's how to prepare and align the text and the buttons:

1. Use the Eyedropper tool to sample the dark brown on the door to make it the current Object color. 

2. Choose the Type tool. Click somewhere in the image. When the Type Tool dialog box opens, change the font to Times or Times New Roman. Change the Font Size to 12 points and the Tracking to 0. 

3. Type the words "Discussion Group." This is the label for the first button.

4. Choose the Selection tool and move the label so that it's inside the first button at the top of the navigation bar. Press the Shift key and click to select the rounded rectangle as well. With both items now selected, choose Object | Align | Centers. 

Illustration 9
Tip: It's easy to select the correct alignment option because the menu selection shows a picture of result of each command.

5. So that you can keep each button as a unit it you need to move it, you need to make a group out of the rectangle and the text. Grouping allows you to treat multiple objects as if they were one. To group the two objects, choose Object | Group. 

6. Repeat Steps 2-5 to create the remaining labels and group them with their buttons. The labels that you are to create are: Diet and Exercise, Women's Issues, Men's Health, and For Children. 

If you change this to Women’s Issues you would also need to change your figure so maybe forget it? Jc Megg, your call!( I would have to change a LOT of figures <grin> SL
7. Unlock the Navigation bar on the Timeline.

8. Drag select all of the buttons and then change the Selection tool and Shift+click to add the navigation bar to the selection. Choose Object | Align | Horizontal Centers. Deselect everything. Your navigation bar should look like the one in Figure 2-1.

9. Use the Selection tool to select just the navigation bar. Look at the X: position of the navigation bar in the Transform palette. If it isn't 0, then drag select all of the buttons and the Navigation bar again and use the up or down arrow key to move the entire unit in the correct direction. For example, after I aligned the objects, the navigation bar was set to -3 X: position. That meant that the bar was three pixels above the start of the Composition window. I pressed the down arrow key three times to bring the unit back into the correct 0 position. 

10. Deselect everything and then select the navigation bar again. Check to make sure that it is at 0, 0 in the Transform palette. You're now ready to set up the links.

11. Save your work.

 (2)Stack Objects 

Earlier in this chapter, I mentioned that every object that you create in LiveMotion is on the same plane. LiveMotion has no layers to organize the composition. This isn't an oversight; it's really a deliberate choice made by the program developers.

Because all objects are on the same plane, you need a way to specify which objects will appear on top and which will appear on the bottom. This is called the "object stacking order." You can alter it by use of the Object | Arrange commands (as you already have). If you make no changes to the stacking order of the objects in your image, you'll discover that they are stacked according to the order in which they were created. The earliest objects are at the bottom of the stack.

Tip:  If you need to view the stacking order of all of your objects, you can see it in the Timeline (but you can't change it there). 

You have four choices to rearrange the stacking order. They are: Bring to Front, Bring Forward, Send to Back, and Send Backward. If you have used either Photoshop, Illustrator, Freehand, CorelDraw, PageMaker, InDesign, or QuarkXPress (or almost any other major graphics application), you will have used these commands before. All of your objects are now in the correct stacking order, but I wanted to make sure that you understood the significance of the Object | Arrange commands.

 (1)Create Button Links

I'm sure you know what a button is on a Web site, but can you define it? At its simplest level, a button is an object that you click on to go somewhere else. If you can click on something and change the Web page that you're viewing or change the location on the Web page, then you've clicked on a button.

That is a simplistic definition. In LiveMotion, a button is an object that contains more than just the "normal" state. So what's a state? (Don't tell me "California.") (() A state is a condition that occurs based on the location of the site visitor's mouse cursor. The "normal" state occurs when nothing is happening: the mouse isn't in the object nor is the mouse button pressed. 

LiveMotion recognizes four standard button states: Normal, Down, Over, and Out. You'll learn much more about these various states when you create rollovers in Chapter 6. For now, all that you need to know is that you need to create a Down state for all of your buttons so that when the site visitor clicks on a button, a new page appears. 

Here's how to create the button links:

1. Select the first button. 

When I selected the “first button” I assumed I selected the rounded rectangle and not just the text?  Are the two (rectangle and text) supposed to be merged into one button object? Jc Jody, some reference numbers were wrong and I added an explicit reminder to GROUP each button. SL
2. Make the Rollover palette active.

3. Click on the Duplicate State icon at the bottom of the Rollover palette as shown in Figure 2-13 (it looks like two pieces of paper on top of one another). The duplicated state is set to Over.

Figure 13: Setting The Over State
Figure 2-13 callouts:
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4. Click on the tiny arrows next to the Over state to reveal the drop-down menu. Select the Down state. When site visitors click the mouse button on the object, you want them to go to a new URL.
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5. In the Web palette, enter discuss.html in the URL field in all lower case. Leave the other fields unchanged. 

Illustration 11
6. Repeat Steps 1-5 for the remaining buttons. The table below gives you the needed information.

Button
URL

Diet and Exercise
diet.html

Woman's Issues
woman.html

Men's health
men.html

For Children
children.html

Table 1: Buttons and their related html page

7. Save your work.

(1)Create HTML code for the Linked Pages 

You'll need to have "placeholder" html pages for your links, just to be able to test them. To create these placeholder pages, you'll need to work in a text editor such as SimpleText on the Macintosh or Notepad on Windows. You could use a word processing program as well, but you must save the finished file as ASCII text (i.e. plain text). Here's the HTML code that I wrote for the Discussion group page:

<html>

<head>

</head>

<body>

<p>This is the discussion page</p>

</body>

<html>

This HTML is about as simple and basic as it gets. When you select the link, all you'll see is the text "This is the discussion page." 

Here's how to create the code:

1. In a text editor, type in the text shown above. 

2. Save the text as discuss.html (all lower case). 

3. Create four more files that are identical to the one that you just created. Change the text between the <p> and </p> tags to reflect the topic of the page—just so that you know that the link is working correctly. Save each file with a different name (use the names shown in Table 1). 

4. Create a new folder for all five files. I called mine LIFESTYLE. It doesn't matter where you create the folder. All that's important is that all of the HTML files and the exported Flash movie with attached HTML are placed in the same folder. 

CAUTION: If the Flash movie is not in the same folder as the HTML placeholders, your links won't work. You specified the URLs in the Web palette using relative addressing and the only way that the generated code will be able to find your pages is if they are kept together at the same level. The advantage to using relative addressing is that you can test your page without having to upload the entire web site to its intended Internet location. 

5. Move all of your HTML files into the new folder. 

Note: The technique that you're using here, of having buttons link to new HTML pages, is not one that you will commonly use. If you're exporting a Flash movie, most, if not all, of your pages will be contained in the same Flash movie. For now, calling a new HTML page is the simplest possible way to create this page, even if it's not the most efficient way.

 (1)Export Flash Movies

You're finally ready to preview and generate your page. You'll learn more about the options and have many more chances to practice this in the remaining chapters of this book. For now, I am using, again, the simplest steps and options that are possible.

Here's how to preview and generate your page:

1. Turn on Preview Export Compression (View | Preview Export Compression). 

2. Select each object in turn to make sure that the Pen icon shows to indicate that you have vector graphics. The page size should be approximately 1.92 kb. 

3. Turn off Preview Export Compression (View | Preview Export Compression). 

4. Save your work. 

5. Choose File | Preview In and select your preferred browser. Check to make sure that the page displays properly.

6. Exit the browser and close it.

7. Choose File | Export and navigate to the same folder where you've stored the HTML placeholder pages. Use that as your export location. On the Mac, you'll see the name of the HTML file that you want to create. On Windows, your file type should be set to .swf. Click on Save to export the file.  (I clicked “Save” on the PC) jc OK
8. Launch your browser again. Drag the generated HTML file into the open browser window. Your Flash movie should play. 

When I tried to check my link buttons, the little hand (indicating a link) only appeared if I was right on the edge of each rounded rectangle (not in the middle) and when I clicked, nothing happened.  I even tried changing the file names to .htm (for windows) instead of .html – but no go.  You did not actually tell me to test these but I thought they would work.  Any ideas?  Jc For the moment, I am inclined to call it a bug <sigh> it doesn’t work on mine either, I just realized. I will check on this in the newer build. SL
Note: LiveMotion also generates an export report. It is the HTML code that has an R in front of the .html extension. (If you called the file "lifestyle," then you'll have another file named lifestyleR.html.) You'll learn more about this report file and how to use it in Chapter 16.

In this chapter, you learned how to create a complete Web page that would export as all vector objects in a Flash movie. Along the way, you learned about the LiveMotion interface, how to create geometric objects, how to use library objects, and how to apply opacity gradients. You also learned how to arrange objects on your page, set type, create buttons and link them, and export a Flash movie. All of these are basic LiveMotion skills that you'll use throughout this book. 

In Chapter 3, you'll learn how to create raster objects, apply styles, use Alpha channels, and apply textures. 
Whew!  Great chapter!  What a workout! Jc Thanks! SL
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